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Introduction

This demonstration guide illustrates how the DTMB (CTTB)  

measurement application adds convenience to DTMB (CTTB) system 

development and manufacturing for both multi-carrier and single-

carrier schemes with one-button measurements including standard 

presets and remote SCPI programming capabilities on  

the X-Series signal analyzers. 
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DTMB (CTTB) Digital Video

Measurement Details

All of the RF transmitter measurements  

as defined by the DTMB (CTTB) 

standard, as well as a wide range of 

additional measurements and analysis 

tools, are available with a press of a 

button (Table 2). These measurements 

are fully remote controllable via the 

IEC/IEEE bus or LAN, using SCPI 

commands. 

Analog baseband measurements are 

available on the MXA signal analyzer  

equipped with BBIQ hardware. 

Supported baseband measurements 

include all of the modulation quality 

plus I/Q waveform and CCDF  

measurements.

Technology DTMB (CTTB)

Measurement application N6156A, W6156A

X-Series signal analyzer PXA, MXA, EXA, CXA

Measurements Channel power

RF spectrum

Shoulder attenuation

Spectrum mask (with analog TV in adjacent channel)

Adjacent channel power

Spectrum emission mask

Monitor spectrum

IQ waveform

Modulation accuracy

RMS EVM (%)

Peak EVM (%)

Position of peak EVM

RMS MER (dB)

Peak MER (dB)

Position of peak MER

RMS mag error (%)

Peak mag error (%)

Position of peak mag error

RMS phase error (deg)

Peak phase error (deg)

Position of peak phase error

Frequency error (Hz)

Clock error (Hz)

Tx power (dBm)

Quadrature error (deg)

Amplitude imbalance (%)

MER/EVM vs. subcarriers/frequency

Ampt vs subcarriers (dB)

Phase vs subcarriers (deg)

Group Delay vs subcarriers (ns)   

Channel impulse response (dB)

MER of data block (dB)

MER of system info (dB)

MER of header (dB)

In-band spectrum ripple Amax-Ac (dB)

In-band spectrum ripple Amin-Ac (dB)
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Demonstration Preparation

Minimum equipment  
coniguration requirements
All demonstrations use an X-Series 

signal analyzer and the N5182A MXG 

vector signal generator.

Product type Model number Required options

MXG vector signal 

generator

N5182A  

(Firmware revision 

A.01.20 or later)

 – 651, 652, or 654 – internal baseband 

generator (30 M/60 M/125 MSa/s,  

8 MSa)

 –  019 – Upgrade baseband generator 

memory to 64 MSa (recommended)

Signal Studio for 

digital video

N7623B  

(Software version 

1.6.4.0 or later)

Please check N7623B Signal Studio  

Web page for the latest version  

www.keysight.com/find/SignalStudio

X-Series signal 

analyzer

N9000A, N9010A, 

N9020A, or N9030A1 

firmware revision 

A.06.xx or later

Recommended:

 – EA3 – Electric attenuator, 3.6 GHz

 – POx – Preamplifier

 – P0x (P03, P08 (P07 for CXA))

 – B25, B40 or B1X – Analysis bandwidth up 

to 25 MHz, 40 MHz or 140 MHz

 – BBA – Analog baseband IQ inputs (for 

analog baseband IQ analysis) for N9020A 

MXA

Required:

 – 503, 508, 507, (EXA and CXA), 513 or 

526–513 and 526 not available on CXA 

DTMB (CTTB)  

measurement 

application

N6156A – N9010A,  

N9020A, N9030A

W6156A – N9000A 

only

Required:

 – 2FP: DTMB (CTTB) measurement  

application, fixed perpetual license

OR

 – 2TP: DTMB (CTTB) measurement  

application, transportable license  

(For N9010A, N9020A, and N9030A)

Controller PC for 

Signal Studio for 

digital video1

 

Install N7623B to generate and download 

the signal waveform into the MXG via 

GPIB or LAN (TCP/IP)—please refer to the 

online documentation for installation and 

setup

1. Keysight X-Series PXA/MXA/EXA/CXA signal analyzers can be used as the controller PC to install  

the N7623B Signal Studio software and download waveforms into the MXG via LAN or GPIB.

Helpful tip:

Update your instrument firmware and software to 

the latest version, at

www.keysight.com/find/xseries_software

www.keysight.com/find/signalstudio

http://www.keysight.com/find/SignalStudio
http://www.keysight.com/find/xseries_software
http://www.keysight.com/find/signalstudio
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N7623B Digital 

Video Signal Studio

10 MHz Ref

LAN/GPIB

MXG 

RF Out

X-Series 

Signal 

Analyzer, 

RF In

Figure 1. Demonstration setup 

Demonstration Setup

Connect the PC,  
X-Series, and MXG

Connect a PC (loaded with Keysight 

N7623B Signal Studio for Digital Video  

software and Keysight I/O libraries) 

to the N5182A MXG via GPIB or LAN. 

Follow the Signal Studio instruction 

to complete the connection, and then 

perform the following steps to inter-

connect the X-Series signal analyzer 

and MXG (see Figure 1 for a graphical 

overview):

A. Connect the MXG RF output port 

to the X-Series signal analyzer  

RF input port

B. Connect the MXG 10 MHz out  

to the X-Series signal analyzer  

Ext Ref in port (rear panel)  
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Demonstrations

Demonstration 1: 

Set up Digital Video Signal 
Studio on MXG

The Keysight N7623B Signal Studio 

for Digital Video is a Windows-based 

utility that simplifies the creation of 

DTMB (CTTB) signals. These signal 

parameters are downloaded into the 

MXG vector signal generator, which 

creates the desired waveform.

Instructions  Keystrokes

On the MXG:

Preset the MXG

Check the IP address

[Preset]

[Utility] {I/O Config} {LAN Setup}

On the Signal Studio software:

Run the Keysight Signal Studio for 

digital video

Double-click on the Digital Video shortcut on the desk-

top or access the program via the Windows start menu

Verify the software is communi-

cating with the instrument via the 

GPIB or LAN (TCP/IP) link

To establish a new connection, click on the {System} 

pull-down menu at the top of the Signal Studio program 

window. Next, select {Run System Configuration Wizard}

Select the DTMB (CTTB) format
Click on the {Format} pull-down menu at the top of the 

Signal Studio program window. Next, select {DTMB}

Set the parameters of the signal 

generator with center frequency 

474 MHz, amplitude –20 dBm,  

RF Output turned on, and ALC On

Click Signal Generator at the left on the Explorer menu.

Instrument model number: N5162A/N5182A

Press [Preset] green button at the top.

Frequency = 474 MHz, Amplitude = –20 dBm,

RF Output = On, ALC = On

Confirm the waveform setup from 

upper level

Click Waveform Setup to see the fundamental waveform  

signal setups, set DTMB (CTTB) common parameters as 

follows:

Oversampling ratio = 2, Mirror Spectrum = Off, 

Quadrature angle adjustment = 0 deg,  

I/Q gain balance = 0 dB

Set a test signal for  

demonstrations

Click Carrier0 under Waveform Setup on the left of the 

explorer menu. Here use the default setting of reference 

spec. Figure 2 shows the signals setting

Download the signal to the MXG Click  on the top tool bar. If you encounter any errors, 

please refer to the online help of Signal Studio software

Save the signal file for future use File > Save Setting File > DTMB1.scp (create filename)

Export the waveform file for  

future use

File > Export Waveform Data > DTMB.wfm  

(create filename)

Figure 2. DTMB (CTTB) signals setup in the Keysight Signal Studio software
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Demonstration 2:

Channel power 

The channel power measurement has 

three views: RF spectrum, shoulder 

attenuation, and spectrum mask. 

The RF spectrum view measures  

and reports the integrated power in 

a DTMB (CTTB) defined bandwidth 

and power spectral density (PSD) 

displayed in dBm/Hz or dBm/MHz. 

The shoulder attenuation view  

measures the power difference 

between the center frequency (CF) 

and the shoulder point (4.2 MHz from 

CF for 8 MHz bandwidth).

The spectrum mask view compares 

the input signal against the DTMB 

(CTTB) defined spectrum mask for the  

condition of analog TV signal in 

adjacent channel.

Figure 3. Channel power measurement with RF spectrum view 

Figure 4. Channel power measurement with shoulder attenuation view

RF spectrum and shoulder attenuation view

Instructions  Keystrokes

On the X-Series in DTMB (CTTB) mode:

Preset the MXA/EXA [Mode Preset]

Select DTMB (CTTB) mode [Mode] {DTMB}

Choose the device under test [Mode Setup] {Device Type} {Transmitter}

Set a center frequency at 474 MHz [FREQ Channel] {Center Freq} {474} {MHz}

Set channel bandwidth at 8 MHz [Mode Setup] {Channel BW} {8 MHz}

Select channel power measurement  

(RF spectrum default)
[Meas] {Channel Power}

Switch to shoulder attenuation view [View/Display] {Shoulder Attenuation}
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Figure 5. Diagram for spectrum mask measurement on DTMB (CTTB) transmitter 

without output filter

Figure 6. Diagram for spectrum mask measurement on a DTMB (CTTB) transmitter 

without an output filter

Input signal COFDM

exciter

Power

amplifier

Output

filter

Signal

analyzer
Attenuator

RF output

DTMB transmitter (UUT)

A

Input signal COFDM

exciter

Power

amplifier

External

filter

Signal

analyzer
Attenuator

RF output

DTMB transmitter (UUT)

B

Spectrum mask view 

The dynamic range of the RF output 

of a real DTMB (CTTB) transmitter 

typically exceeds the dynamic range 

of the analyzer. Therefore, the direct  

measurement result is always “FAIL” 

and cannot reflect the real RF output.

To measure the spectrum mask of the 

transmitter’s RF output, there are two 

methods.

Method 1

When the DTMB (CTTB) transmitter 

has an output filter, the diagram for 

the spectrum mask measurement is 

shown in Figure 5.

Three steps for measuring the  

spectrum mask are as follows:

A.  Measure the frequency response of 

the output filter using a network  

analyzer or a combination of 

signal source and signal analyzer.

B. Measure the signal transmitted at 

point A as shown in Figure 5.

C. Apply amplitude correction on 

spectrum value measured in (2) 

using the filter’s response from (1).

Method 2 

When the transmitter does not have 

an output filter, an external filter with 

a band-block filter frequency response 

should be added after the transmitter 

for the measurement arrangement 

shown in Figure 6.

The steps for measuring the spectrum 

mask are as follows:

A.  Measure the frequency response 

of the output filter using a network  

analyzer or a combination of  

signal source and signal analyzer.

B.  Measure the signal transmitted  

at point B as shown in Figure 6.

C.  Apply amplitude correction on 

spectrum value measured in (2) 

using the filter’s response from (1).

The correction data is typically a table 

of the filter’s frequency response in 

dB, at a number of frequency points 

across the band.

The correction data is typically a table 

of the negative values of this band-

block filter’s frequency response in 

dB, at a number of frequency points 

across the band.

This spectrum mask measurement 

is used in case there are analog TV 

signals in the adjacent channel.
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Instructions  Keystrokes

On the X-Series in DTMB (CTTB) mode:

Select the spectrum mask view [View/Display] {Spectrum Mask}

Input the value of the attenuator  

(for real DTMB (CTTB) transmitter)

[Input/Output] {External Gain}  

{Ext Preamp}

Recall or edit the correction table
[Input/Output] {More 1 of 2} {Corrections} 

{Edit} or [Recall] {Data}

Turn the correction on [Input/Output] {More 1 of 2} {Corrections} {On}

Figure 7. Channel power measurements using the spectrum mask view

Figure 8. Channel power measurements using the spectrum mask view after amplitude 

correction

Note: In spectrum mask view, if the 

device type is exciter or the band-

width is 6 MHz, the mask trace will 

not be displayed and a “No Result” 

message will be displayed because 

the spectrum masks for those cases 

are not defined in the DTMB (CTTB) 

specifications. 
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Demonstration 3:

Adjacent channel power (ACP)

ACP is a measurement of the power 

in adjacent in-band or out-band chan-

nels relative to the transmitted power. 

The ACP test verifies the ability of 

the modulator or transmitter to limit 

the interference produced by the 

transmitted signal to other receivers 

operating at the adjacent in-band or 

adjacent out-band RF channel.

The ACP measurement results should 

look like Figure 9. The text window 

shows the power inside adjacent 

channel and outside adjacent channel 

as the standard requires.

Figure 9. ACP measurement with noise correction on

Instructions  Keystrokes

On the X-Series in DTMB (CTTB) mode:

Activate adjacent channel power  

measurement
[Meas] {ACP}

Compare the measurement result with 

Noise Correction turned on (default is off). 

A better ACP result is achieved with noise 

correction on (Figure 9)

[Meas Setup] {More 1 of 2}  

{Noise Correction On}
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Demonstration 4: 

Power stat CCDF)

The power stat CCDF (complementary 

cumulative distortion function) is a 

statistical method used to interpret 

the peak-to-average ratio of digitally 

modulated noise-like signals. It is a 

key tool for the power amplifier design  

in DTMB (CTTB) transmitters, which 

is particularly challenging because 

the amplifier must be capable of 

handling the high peak-to-average 

ratio while maintaining good adjacent 

channel leakage performance.

Figure 10. Power stat CCDF measurement

Figure 11. Power stat CCDF measurement with reference trace

Instructions Keystrokes

On the X-Series in DTMB (CTTB) mode:

Activate the X-Series measurement [Meas] {Power Stat CCDF}

Store a reference trace [Trace/Detector] {Store Ref Trace}

Turn on reference trace [Trace/Detector] {Ref Trace On}
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Demonstration 5: 

Spectrum emission mask

The spectrum emission mask (SEM) 

measurement can compare the total 

power level within the defined carrier  

bandwidth and the given offset 

channel on both sides of the carrier 

frequency to levels allowed by the 

DTMB (CTTB) standard in the strict 

condition. This measurement refers 

to the design of the power amplifier 

in the DTMB (CTTB) transmitter,  

and it is a key measurement linking  

amplifier linearity and other 

performance characteristics to the 

stringent system specifications.

For a detailed process for making 

spectrum emission mask measure-

ments, please refer to the descrip-

tions in channel power measurement 

and spectrum mask view on pages  

7 and 8.

Note: In the spectrum emission mask 

measurement, if the device type is 

exciter or the bandwidth is 6 MHz, 

the mask trace will be displayed as 

a horizontal line on the top of the 

screen. You can then define the mask 

trace manually through [Meas Setup] 

{Offset/Limit}.

Figure 12. Spectrum emission mask measurement

Instructions Keystrokes

On the X-Series in DTMB (CTTB) mode:

Activate spectrum emission mask [Meas] {Spectrum Emissions}

Input the value of the attenuator  

(for real DTMB (CTTB) transmitter)
[Input/Output] {External Gain} {Ext Preamp}

Recall or edit the correction table
[Input/Output] {More 1 of 2} {Corrections} 

{Edit} or [Recall] {Data}

Turn correction on [Input/Output] {More 1 of 2} {Corrections} {On}

Figure 13. Spectrum emission mask measurement after amplitude correction
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Demonstration 6: 

Modulation accuracy

The modulation accuracy measure-

ment is necessary to meet DTMB 

(CTTB) defined tests and to ensure 

proper operations of exciters or trans-

mitters. Error vector magnitude (EVM) 

and modulation error ration (MER) are 

defined in the DTMB (CTTB) standard 

to present the total signal degradation 

including noise, interferences or 

distortions at the input of a com-

mercial receiver’s decision circuits 

to give an indication of the ability 

of that receiver to correctly decode 

the signal. EVM is a measurement 

parameter for evaluating the quality of 

a modulation, and it is widely used in 

digital communications. MER is a rep-

resentation of the distance between 

measured and theoretical constella-

tion points, which is an indicator of 

noise, interferences, or distortions 

on a signal. MER is usually used in 

broadcasting applications. MER and 

EVM can convert each other.

In the Keysight X-Series DTMB (CTTB)  

application, the modulation accuracy 

measurement provides many methods 

for measuring and analyzing modula-

tion quality. In this measurement, 

you can measure the EVM, MER, 

magnitude error, phase error, freq 

error, quadrature error, amplitude 

imbalance etc.

Available views and traces in  

modulation accuracy:

 – I/Q measured polar graph view 

(Figure 14): This is a two-window 

view. For multi-carrier mode, I/Q 

measured polar data trace can be 

calculated on selected sub-carriers.

 – Results metrics (left)

 – I/Q measured polar graph (right)

 – I/Q error view (Quad view)  

(Figure 15): This is a four-window 

view which includes:

 – MER/EVM vs. sub-carrier/

frequency view (top left and only 

available for multi-carrier mode)

 – Spectrum (top right and only 

available for multi-carrier mode)

 – I/Q measured polar graph  

(bottom left)

 – Results metrics (bottom right)

 – Channel frequency response view 

(Figure 16): This is a three-window 

view only available for multi-carrier 

mode which includes:

 – Amplitude vs. sub-carrier (top)

 – Phase vs. sub-carrier (middle)

 – Group delay vs. sub-carrier  

(bottom)

 – Channel impulse response view 

(Figure 17): This two-window view 

displays the state of the channel in 

time domain which the signal has 

gone through.

 – Peak table window (left)

 – Amplitude vs. time trace (right).

 – Spectrum flatness view (Figure 18): 

This two-window view can be used 

to verify whether the spectrum 

flatness meets the transmitter 

or exciter device standard with a 

PASS/FAIL indicator.

 – Amplitude vs. sub-carrier (top)

 – Results metrics (bottom)

 – Result metrics view (Figure 19): 

This view displays the summary 

of all the detailed numeric result 

metrics.
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Figure 14. Modulation accuracy measurement with I/Q measured polar graph view

Figure 15. Modulation accuracy measurements with I/Q error view (Quad view)

Instructions  Keystrokes

On the X-Series in DTMB (CTTB) mode:

Select demodulation options

[Mode Setup] {Demod} Select the  

demodulation options under this menu 

according to the transmitted signal’s format 

Activate modulation accuracy  

measurement (I/Q measured polar  

graph default, Figure 14)

[Meas] {Mod Accuracy}

Switch to the IQ error view (Figure 15) [View/Display] {I/Q Error (Quad View)}

View the channel frequency response 

(Figure 16)

[View/Display]  

{Channel Frequency Response}

View the channel impulse response 

(Figure 17)

[View/Display] {Channel Impulse 

Response}

View the spectrum flatness (Figure 18) [View/Display] {Spectrum Flatness}

View result metrics (Figure 19) [View/Display] {Result Metrics}
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Figure 16. Modulation accuracy measurement with channel frequency 

response view

Figure 18. Modulation accuracy measurement with spectrum flatness view

Figure 17. Modulation accuracy measurement with channel impulse 

response view

Figure 19. Modulation accuracy measurement with result metrics view
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Demonstration 7: 

Monitor spectrum

The monitor spectrum measurement 

is used as a quick, convenient means 

of looking at the entire spectrum. 

While it is similar to the spectrum 

analyzer mode, the functionality is 

greatly reduced for easy operation. 

The main purpose of the measure-

ment is to show the spectrum.

Instructions Keystrokes

On the X-Series in DTMB (CTTB) mode:

Activate monitor spectrum measurement [Meas] {Monitor Spectrum}

Figure 20. Monitor spectrum measurement
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Demonstration 8: 

IQ waveform

The waveform measurement is a 

generic measurement for viewing the 

input signal waveforms in the time 

domain. Under this measurement 

there is also an I/Q Waveform win-

dow, which shows the I and Q signal 

waveforms in parameters of voltage 

versus time to disclose the voltages, 

which comprise the complex modu-

lated waveform of a digital signal.

The waveform measurement can also 

be used to perform general purpose 

power measurements to a high 

degree of accuracy.

Instructions Keystrokes

On the X-Series in DTMB (CTTB) mode:

Activate IQ waveform measurement

(RF envelope default)
[Meas] {IQ Waveform}

View the I/Q waveform [View/Display] {I/Q Waveform}

Figure 21. Waveform measurement with RF envelope view

Figure 22. Waveform measurement with I/Q waveform view
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Demonstration 9: 

Making DTMB (CTTB) signal 
measurement in single  
carrier mode

The N6156A & W6156A measure-

ment applications also support the 

measurement of single mode DTMB 

(CTTB) signals. Set up Signal Studio 

for Digital Video and PXA/MXA/

EXA/CXA as follows (this example 

shows the DTMB (CTTB) signal in 

single carrier mode with pilot  

insertion):

Instructions Keystrokes

On the Signal Studio software:

Configure a test signal for demonstrations

Click Carrier0 (DTMB Settings) under 

Waveform Setup on the left of the 

explorer menu

Carrier0: Sub-Carrier Number = 1,  

Insert Pilot = True. For other parameters, 

use the default settings of reference spec

Figure 23. Channel power measurement on a DTMB (CTTB) signal in single carrier mode

Channel power

The channel power measurement 

shows the spectrum of the signal.  

The two vpeak values on each side 

of the spectrum is the inserted dual-

pilot. The frequency distance between 

the two pilots should be equal to the 

symbol rate. 
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Modulation accuracy

In single carrier mode, the insertion 

method of the dual-pilot is to add 

1+j*0 to the odd symbol and add 

-1+j*0 to the even symbol, counted 

from the first symbol of a day frame. 

The constellation diagram is shown in 

Figure 24.

Instructions Keystrokes

On the X-Series in DTMB (CTTB) mode:

Select demodulation options
[Mode Setup] {Demod} {Carrier Format} 

{Single Carrier} {Pilot Insertion} {On}

Activate modulation accuracy measurement 

(I/Q measured polar graph default,  

Figure 24)

[Meas] {Mod Accuracy}

Figure 24. Constellation diagram of a DTMB (CTTB) signal in single carrier mode

Web Resources

Product page:  

www.keysight.com/find/n6156a and  

www.keysight.com/find/w6156a

X-Series signal analyzers:  

www.keysight.com/find/X-Series

X-Series advanced measurement applications:  

www.keysight.com/find/X-Series_Apps

Signal Studio software:  

www.keysight.com/find/digitalvideo

Signal Studio software:  

www.keysight.com/find/SignalStudio

Signal generators:  

www.keysight.com/find/sg

http://www.keysight.com/find/n6156a
http://www.keysight.com/find/w6156a
http://www.keysight.com/find/X-Series
http://www.keysight.com/find/X-Series_Apps
http://www.keysight.com/find/digitalvideo
http://www.keysight.com/find/SignalStudio
http://www.keysight.com/find/sg
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